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General rules of behavior

Before starting with the experiment on one of the most interesting and fascinating thing
in the world, it is useful to define the rules that everyone of us has to follow inside and
outside the laboratory. Do not skip this part and do not forget it!

❼ Before entering the lab, place the jackets in the dedicated room

❼ Do not leave food in the wardrobe room. In case you have no place where to leave
the not strictly necessary things, ask the supervisors

❼ Do not touch the radioactive sources with your hands! There are tweezers to move
them...

❼ Always remember your dosimeter that has always to be with you. Attach it to a
pocket or wherever you find it comfortable close to your body and do not leave it
on the desk or in the bag

❼ Follow the indication in these instructions so that the apparatus can be preserved
intact

❼ Don’t worry about speaking English with the tutors: not a single point will be
deduced if you are not confident with the language

❼ In case you need the tutors for whatever important reason, do not be shy and
contact them

And...

... if you believe, like we do, that particle detectors are really cool, come and ask for a
thesis in this field: in our institute there are several opportunities!
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1. Introduction

This experiment is designed to give you basic knowledge about the working principles
of particle detectors. Figure 1.1 shows a cross-sectional view of the Compact Muon

Figure 1.1.: Cross-sectional view of the CMS detector.

Solenoid detector, which is one of the four large experiments at the Large Hadron Col-
lider. There are two basic ways of measuring particle properties.
First, a charged particle momentum may be measured by determining the curvature of
its trajectory in a magnetic field. This is e.g. done in the so called tracker, which is a
detector with a very good spatial resolution and allows for a precise trajectory measure-
ment. The precision of this process is limited by the influence of multiple scattering due
to the material present in the structure of the detectors, which causes a deflection of the
particle path.
Second, a calorimeter can be used to measure the energy deposited by a traversing par-
ticle, that depends on the particle velocity. In CMS, there is an electromagnetic and a
hadronic calorimeter. The electromagnetic calorimeter (ECAL) is used for the detection
of photons and electrons/positrons, while the hadronic calorimeter (HCAL) is used to
detect hadrons such as protons or kaons.
By determining the energy and the momentum, all the other properties of the particles
can be derived, such as the mass and the pT of the particles.
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2. Theory

While in the LHC the particles crossing the detectors are produced making proton
beams collide, in this laboratory experiment we will use electrons and positions (e+, e−)
generated by the β-decay of radioactive sources.

2.1. β-decays

Nuclei with a large imbalance of proton and neutron content decay via the weak inter-
action. This decay is called β-decay. There are β−- and β+- decays, depending on the
sign of the β particle generated:

n→ p + e− + ν̃ (2.1)

p→ n + e+ + ν (2.2)

The first one occurs in neutron-rich nuclides. A neutron is transformed into a proton,
which causes an electron and anti-neutrino to be emitted from the nucleus.
The opposite happen for proton-rich nuclei, which undergo β+-decays. Here, a proton
is transformed into a neutron and a positron and a neutrino are emitted. Energy cor-
responding to the mass difference between the parent nucleus and its decay products is
released. This energy release is typically of the order of 1 MeV.

2.1.1. The β-spectrum

In contrast to the α-spectrum, the β spectrum is not discrete but continuous from zero
to the maximal possible energy. The spectrum can be calculated from Fermi ”Golden
Rule”, which describes the transition probability per unit time for a certain initial to
final state process:

w =
2π

ℏ

∣

∣

∣
⟨ψf | ĤS |ψi⟩

∣

∣

∣

2 dN

dE0

(2.3)

ψ(r⃗) =
1√
V
e

ip⃗·r⃗
ℏ (2.4)

For the β-decay, the transition is from the initial nucleus to the final nucleus plus an anti-
neutrino and free electron with a momentum between pe and pe + dpe. The transition
probability depends on the matrix element and the density dN/dE0 of possible final
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states.
The weak interaction has a very short range and practically only affects the interior of
the nucleus. Therefore, the wave function in the matrix element may be approximated
using plane waves.

exp

(

ip⃗ · r⃗
ℏ

)

≈ 1 + i
p⃗ · r⃗
ℏ

− 1

2

(

(p⃗ · r⃗)
ℏ

)2

(2.5)

Indeed, using pe ∼ 1 MeV/c and r ∼ 10−15 m, we get p⃗e·r⃗
ℏ

≈ 10−3. Assuming that the
wave function is approximately constant over the extent of the nucleus, we can write:

∣

∣

∣
⟨ψf | ĤS |ψi⟩

∣

∣

∣

2

=
g2 |Mfi|2
V 2

(2.6)

where g is a coupling constant that parametrizes the strength of the weak interaction
and |Mfi| is the nucleus matrix element containing the wave function. V is a normalizing
factor for the wave function.
This equation tells us that electron and neutrino do not carry away any angular mo-
mentum. Thus, the transition is allowed (see below).
To calculate the density of allowed final states, we need to take into account that the
released energy is shared between electron and neutrino: E0 = Ee +Eν . Also, the total
momentum of the system must be conserved. The nucleus is much heavier than elec-
tron and neutrino, which allows us to neglect the recoil energy carried by it. The total
number of states dN is a combination of the electron and neutrino states:

dN = dnednν (2.7)

where location and momentum are related by the uncertainty relation d3xd3p ≥ (2πℏ)3.
Each states occupies a phase volume of h3, thus the total density of states is:

dN

dE0

=
V

(2πℏ)3
4πp2edpe

V

(2πℏ)3
4πp2ν

dpν
dE0

=
16π2V2

(2πℏ)6
p2ep

2
ν

dpν
dE0

dpe (2.8)

where we have assumed that the interaction is confined to the volume V. This is possible
due to the short range of the weak interaction. Neglecting neutrino masses, we arrive at

p2νdpν =
(E0 − Ee)

2

c3
dE0 (2.9)

and thus

dw(pe) =
2g2

(2π)3ℏ7c3
|Mfi|2 (E0 − Ee)

2p2edpe = K |Mfi|2 p2e(E0 − Ee)
2dpe. (2.10)
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Figure 2.1.: Momentum spectrum with and without Fermi correction.

We can now replace Ee by the kinetic energy of the electron Te = Ee − me as it is
measured in the scintillator and dpe by dTe, which gives

dw(Te) = K |Mfi|2 (Emax − Ee)
2(Te +me)

√

T 2
e + 2TemedTe (2.11)

Note: In literature, it is common to only give the maximal kinetic energy of the electron
Emax as decay energy.

2.1.2. Fermi correction

Up to this point we have neglected the Coulomb interaction between nucleon and elec-
tron/positron. When leaving the nucleon’s electromagnetic field, electrons are deceler-
ated and positrons are accelerated. The strength of this effect depends on the nucleon
charge number Z and the momentum of the emitted particles. In both cases, the spec-
trum is distorted as shown in fig. 2.1. This correction is formulated as the ratio of the
electron wave functions with and without the effect taken into account.

F (Z, η) =
2πη

1− e−2πη
, η = ±ZαEe

pe
(2.12)

where + (−) is used for electrons (positrons). F(Z,pe) is called Fermi function.
The differential momentum distribution is then finally

dw

dpe
= K |Mfi|2 F (Z, pe)p2e(Emax − Ee)

2. (2.13)
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2.1.3. Allowed and prohibited transitions

In all calculations, we have assumed the matrix element to be constant. However, this
is only true for so called “allowed” transitions, where electron and neutrino do not carry
angular momentum. Allowed transitions have high transition probabilities. There are
two kinds of allowed transitions:

Fermi transition:
The spins of electron and neutrino are aligned in opposite directions. A singlet state
(sβ + s̄ν = 0) is formed, the nuclear spin is unchanged (∆J = 0).

Gamow-Teller transition:
Electron and neutrino form a triplet state (sβ + s̄ν = 1). In this case, the nuclear spin
may change by ∆J = ±1, 0, where J = 0 → J = 0 is excluded.

The other transitions are called “prohibited”. The more prohibited they are, the more
the rate is reduced. This means that the electron wave function is not constant over
the extent of the nucleus as assumed in eq. 2.5. Therefore, the approximation has to
be calculated in higher orders, which changes the matrix element. Whether a decay is
prohibited, may be found out by considering the total decay probability per unit time
λ. It is calculated by integrating the momentum spectrum over all possible momenta:

λ =
1

τ
=

∫ pmax

0

dw

dpe
dpe = K |Mfi|2

∫ pmax

0

F (Z, pe)p
2
e(Emax − Ee)

2 dpe (2.14)

We define the kinetic energy per electron mass We =
Ee

mec2

λ = K ′ |Mfi|2
∫ Wmax

1

F (Z,We)
√

W 2
e − 1(Wmax −We)

2 dWe (2.15)

The integral is also called Fermi integral f(Z,Wmax). It only depends on the nuclear
charge Z and Wmax. We replace the mean lifetime by the half-life:

λ =
ln(2)

t1/2
= K ′ |Mfi|2 f(Z,Wmax). (2.16)

And we thus arrive at the so called “ft value”

f(Z,Wmax)t1/2 =
ln(2)

K ′ |Mfi|2
, (2.17)

which may be used to estimate which class of transition a decay belongs to. It only
depends on the matrix element. The value of the Fermi integral f(Z,Wmax) for different
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Z and Wmax can e.g. be found in A.2 in the appendix.
ft values up to 106 are considered allowed, larger values are prohibited. The degree of
prohibition (single, double, etc.) increases approximately every two orders of magnitude.

What kind of transitions are found in 90Sr and 90Y? ... we are going to use the 90Sr in
our experiment!

2.1.4. Kurie diagram

We can now plot
√

dw/dpe
F (Z,pe)p2e

against the electron’s kinetic energy. If |Mfi|2 is indeed

constant, we expect a linear behavior as shown in 2.2. In this view, the maximal energy
is determined by finding the intersection with the x-axis. Additionally, this plot can be
used to spot multiple decay components in the spectrum, which lead to kinks in the line.

Figure 2.2.: Example Kurie diagram for the energy spectrum of Kr85.

2.2. Bending charged particles in magnetic fields

When an electrically charged particle traverses an electromagnetic fields, it is accelerated
as shown in the Lorentz equation 2.18.

F⃗ = q (E⃗ + v⃗ × B⃗) (2.18)

Where q is the particle charge, v⃗ is its velocity and E⃗ and B⃗ are the electric field strength
and the magnetic flux density.
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Figure 2.3.: Electron in a constant homogeneous magnetic field

The first term represents the Coulomb force F⃗C . It linearly accelerates the particle (anti-

) parallel to the field vector E⃗, depending on the particle’s charge sign. The second term,

called Lorentz force F⃗L, is proportional to the particle charge and velocity. Due to the
vector product, the resulting Lorentz force is orthogonal to the plane defined by v⃗ and
B⃗. Thus, the particle path is deflected laterally, reaching the maximal value of deflection
when velocity and magnetic field vectors are orthogonal and vanishes if they are parallel.
A constant magnetic field does not alter the particle energy. To understand this, consider
the following:

dW = F⃗ · dr⃗ = F⃗ · v⃗ dt = q (v⃗ × B⃗) · v⃗ dt = 0 (2.19)

This equation tells us that the kinetic energy and, therefore, the velocity of the particle
do not change when it traverses a constant magnetic field.
Now what happens, when a particle enters a constant, spatially homogeneous magnetic
field? The motion has a circular path (Fig. 2.3).
This is due to the Lorentz force, which acts as a centripetal force. The particle traverses
the circular path with a frequency ω = q

m
B, which is called Larmor frequency.

For a constant magnetic field, only particles with a certain momentum can occupy
circular orbits of a certain radius R0. The dependency may be calculated by equating
the Lorentz force with the general expression for centripetal forces

F⊥ = FL (2.20)

m v2

R0

= qvB , (v⃗ ⊥ B⃗) (2.21)

⇒ mv = p = qBR0 (2.22)

or in natural units:
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p

keV
= 0.3

B

mT

R0

mm
(2.23)

As stated before, the Lorentz force does not perform work, it does not change energy and
speed of the particle. However, the particle is accelerated in the magnetic field, which
leads to the emission of synchrotron radiation. Charged particles that are accelerated
in a direction that is orthogonal to their velocity vector (v⃗ ⊥ ˙⃗v) radiate the power

P ∼ q2

c3
γ4(v̇)2 (2.24)

Which influence does the emission of synchrotron radiation have?

2.2.1. Particle’s momentum measurement in CMS and
tracking detectors

The charged particles crossing the CMS detectors leave ionization signals that are recon-
structed as hits (cross symbols in figure 2.4). Using these spatial information, a track
can be reconstructed by fitting the points with an helix-line. In the transversal view
it assumes the shape of an arc of a circumference of length L and radius R. What is
actually measured rather than the radius is the sagitta s, which is the maximal distance
the track has from the straight line connecting the first and the last hits.

Figure 2.4.: Momentum measurement for charged particles in the CMS experiment.

Considering the θ angle small, the sagitta results:

s = R(1− cosθ) ≈ Rθ2

2
=
L2

8R
(2.25)

So, obtaining R from the previous equation and substituting it into the generic momen-
tum equation 2.23, we get the momentum equation depending on L, s and B:

p = 0.3BR ≈= 0.3B
L2

8s
(2.26)
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2.3. Energy loss of electrons in matter

When particles traverse matter, they lose energy. This energy loss is caused by multiple
effects. Particles may interact with shell electrons which causes excitations or even
ionization. They may also interact with atomic nuclei, mostly by Coulomb scattering,
which leads to the emission of Bremsstrahlung. If a charged particle travels at a speed
higher than the speed of light in the corresponding medium (c′ = c

n
), Čerenkov radiation

is emitted.
In this experiment, ionization and Bremsstrahlung are especially important. They are
explained in more detail below.

2.3.1. Ionization

While the derivation of the formula of the energy loss for electrons and heavier particles
in matter is different, the general approach is the same. Therefore, we will classically
calculate the energy loss of heavy particles with m ≫ me by ionization and then the
result will be translated for electrons. The derivation rests on the assumption that
the energy of the incoming particle is much larger than the binding energy of the shell
electron. Then, if the relative momentum transfer ∆p

p
is small, the electron may be

considered free and the trajectory of the heavy particle is a straight line.

Figure 2.5.: Impact parameter definition.

When a particle with charge Z1e passes close to the atom, the shell electron experiences
a Coulomb force according to

F⃗C =
1

4πϵ0

Z1e

(r2)
e⃗r . (2.27)

The momentum transferred to the electron is

∆p⃗ =

∫ ∞

−∞

F⃗Cdt =
e

v

∫

E⃗⊥dx (2.28)

where the longitudinal force component cancels because F⃗C∥(−x) = −F⃗C∥(x). We use
Gauss divergence theorem, obtaining
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∆p =
Z1e

2

2πϵ0

1

bv
. (2.29)

where b is the so called impact parameter, which quantifies the minimal distance be-
tween electron and incoming particle (see fig. 2.5).
The combined energy transfer to all electrons is calculated by integrating over all elec-
trons in the volume dV . Using cylinder coordinates, we write

∆E =
(∆p)2

2me

nedV =
Z2

1e
4ne

8meπ2ϵ20β
2c2b2

b dϕdbdx (2.30)

where ne is the electron density and β = v
c
. The energy transfer per unit length is

dE

dx
=

e4Z2
1ne

4πϵ20meβ2c2
ln
bmax

bmin

(2.31)

The maximal momentum therefore energy transfer is realized in central collisions, for
which we obtain from eq. 2.29

∆p = 2mecβ =
Z1e

2

2πϵ0βcbmax

(2.32)

⇒ bmax =
Z1e

2

4πϵ0mec2β2
(2.33)

The minimal energy transfer is the amount of energy necessary to ionize the electron.
Therefore,

bmin =
Z1e

2

2πϵ0βc

1√
2meI

(2.34)

where I is the mean ionization energy, which is about 163 eV for aluminum. For heavier
elements, the average ionization energy may be approximated using

I = 9.73Z + 58.8Z−0.19eV, (2.35)

or for composites

ln I =
∑

k

gk ln Ik (2.36)

where gk is the ratio of electrons in atoms of kind k to the total number of electrons.
Putting this into 2.31 yields
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1

ρ

(

dE

dx

)

Ion

=
Z2

1e
4

8πϵ20mec2
1

β2

Z

A
NA ln

(

2meβ
2c2

I

)

(2.37)

for the energy loss per unit length in [dE
dx
] = MeV cm2/g. The electron density was

replaced by ne ≈ Z
A
ρNA, where A is the nucleus mass number and Z is the nuclear

charge of the traversed material, which has a density ρ. The equation tells us that the
energy loss depends on the speed (∝ 1

β2 ) and charge (∝ Z2
1), but not the mass of the

particle. The traversed material is considered in the factors Z
A
and ln(1

I
). Since scattering

is a stochastic process, the formula only gives the average energy loss per unit length.
Now what changes when the incoming particle is an electron? Since the scattering
partners are now equally heavy, the incoming particle does not follow a linear trajectory.
Also, the scattering partners are quantum-mechanically identical particles, which makes
a matching between initial and final state particles impossible. Here, we use the formula
developed by Rohrlich and Carlson in 1954. It expands on work by Bethe.

(

dE

dx

)

ion

=
2πNAr

2
0mec

2

β2

Zρ

A

(

ln(
τ 2(τ + 2)

2(I/mec2)2
) +

τ 2/8− (2τ + 1) ln 2

(τ + 1)2
+ (1− β2)− δ

)

(2.38)

Where r0 =
e2

4πϵ0mec2
is the classical electron radius and τ is the kinetic energy of the pri-

mary electron divided by mec
2, or simply τ = γ−1. δ is a density correction factor that

represents the polarisation of the material caused by the electric charge of the traversing
particle. For large distances, this causes a screening of the shell electrons. This effect is
important for large energies and reduces the energy loss of the electron.

2.3.2. Bremsstrahlung

When charged particles are accelerated in the Coulomb field of atom nuclei, they emit
Bremsstrahlung radiation. The emission is suppressed by the particle mass and thus
only plays a role for light particles such as electrons. The average energy loss per unit
length due to Bremsstrahlung is

(

dE

dx

)

Brems

= 4αNA
Z2

A
r2e ln

(

183

Z
1

3

)

E =
E

X0

, (2.39)

X0 =
A

4αNAZ2r2e ln
(

183

Z
1

3

) (2.40)

where α = 1
137

is the fine-structure constant. The energy loss is proportional to the initial
energy of the incoming electron. X0, called radiation length, is commonly given in g

cm2 .
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It is the length after which the energy of the electron is attenuated by a factor 1/e ≈ 37%.

The energy loss by ionization rises logarithmically at high energies, while Bremsstrahlung
increases linearly. Thus, above some critical energy EC the energy loss is dominated by
Bremsstrahlung. For electrons in materials that are heavier than aluminum the critical
energy may be determined using

EC =
800MeV

Z + 1.2
(2.41)

For composite substances, the average energy loss may be calculated as a combination of
the individual losses for each of the components weighted with the corresponding mass
fraction.

dE

dx tot
=

∑

i

wi

(

dE

dx

)

i

(2.42)

2.4. Multiple scattering

When a particle traverses matter, many scattering processes occur. Each of the scatter-
ing events may change the travel direction of the particle (Fig. 2.6). Charged particles
mainly scatter with the Coulomb field of the nuclei. This process causes the collimated
incoming particle beam to expand in the medium. This affects the possible resolutions in
detectors. Momentum measurements depend on the bending radius of charged particles
in magnetic fields, which again depends on a precise spatial resolution. Since the actual
travel distance in the material is unknown, dE/dx measurements are also distorted.

Figure 2.6.: Scattering in matter causes changes in travel direction of incoming particles.

This process is especially important for electrons. Their low mass facilitates large mo-
mentum transfers and thus large changes in travel directions. The effect of multiple
scattering is described by Molière scattering theory. It states that the angular distribu-
tion is gaussian for small total scattering angles. This may be understood by thinking
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of the total scattering angle as a superposition of many randomly distributed individual
scattering angles. The Central Limit Theorem then states that the superposition is dis-
tributed according to a gaussian.
In this experiment, there are no mono-energetic electron sources, but a qualitative mea-
surement of the effect may also be performed using a β-source.
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3. Experimental setup

The 3 experimental setups for this experiment are:

❼ Momentum resolution, Fig. 3.1;

❼ Energy loss in matter, Fig. 3.2;

❼ Multiple Scattering, Fig. 3.3.

Figure 3.1.: Momentum resolution: experimental setup. The magnetic field produced by
the magnet is controlled by mean of the current generator. The GM counts
are read by the PC.

3.1. Detection devices for nuclear radiation

In this experiment, you are going to use two ways of measuring electrons emitted by the
90Sr source: a Geiger-Müller counter and a scintillator. In the following sections, both
detectors are explained.

3.1.1. Geiger-Müller counter

Geiger-Müller (GM) counters are among the oldest types of detection devices for nuclear
radiation. They consist of a metal cylinder serving as a cathode and a thin wire inside

18



Figure 3.2.: Energy loss in matter: experimental setup. The PC controls both the photo-
multiplier HV settings and its current readout.

Figure 3.3.: Multiple Scattering: experimental setup - top and side view. Three GM
counters (brown cylinders in the yellow cases) mounted on a support (brown)
that can rotate around a pivot point. The radioactive source is placed inside
the collimator (grey) above the pivot point.

the cylinder serving as an anode. Modern GM counters have a window covered with a
low-mass layer (e.g. mica), which improves the detection efficiency. The cylinder is filled
with a counting gas, which is a combination of a noble gas and a so called quenching
gas. When ionizing particles traverse the volume, the gas is ionized along the particle
path. The free electrons move towards the anode and cause a measurable current.
Depending on the applied voltage, the counter may be used in different ways.
The different working points are shown in fig. 3.4. In the recombination region, most
electrons recombine with gas positive ions before reaching the anode. Above the recom-
bination region, the counter may be used as an ionization chamber. Here, all electrons
reach the anode and the measured current is proportional to the energy deposition of
the ionizing particle.
At higher voltages, the proportional and gas amplification regions are reached. The
strong electric field close to the anode accelerates the electrons in such a way that they
again ionize the gas. The measured current pulse is still proportional to the energy
deposition, but it is amplified. Proportional counters can be used to distinguish α- and
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Figure 3.4.: Different operation regions of counter tubes.

β-radiation.
At even higher voltages, the amplification becomes so strong that an ionization avalanche
covers the whole volume. The discharged state persists until the cloud of gas ions has
traveled far enough towards the cathode to screen the electric field. The quenching gas
prevents an additional firing of the tube. The measured current is now independent of
the energy deposition and all particles cause the same signal.
In this experiment, we use a GM counter, that is read out using a Cobra3 system.
Voltage supply and signal output use a BNC cable. A voltage of 500 V is supplied.
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3.1.2. Scintillators

Scintillators are among the most used detectors for nuclear radiation.

Figure 3.5.: Schematic drawing of scintillator and photomultiplier.

A schematic drawing is shown in fig. 3.5. In the scintillating material (Sz), ionizing
radiation causes light flashes, which release electrons from the photo cathode P. Using
a system of dynodes, which initiate emission avalanches, the number of photo-electrons
is multiplied, thus amplifying the signal. The resulting voltage pulse is proportional to
the energy deposition. The scintillation material should absorb as much of the energy
of traversing particles as possible. The conversion fraction of traversing energy to light
energy is called light yield. A linear relationship between the deposited energy amount
and the number of scintillation photons is desirable to ensure a linear current response
in the following. The scintillator should also be transparent to the scintillation light.

There are two types of scintillators with individual advantages. There are organic scin-
tillator (e.g. plastic), which are very fast and only have small dead times. However,
they have a bad energy resolution. Organic scintillators are commonly used as triggers
for other detectors.
The second kind are inorganic scintillators such as NaI(Tl) or CsI, which have good en-
ergy resolution, but they are slow. In this experiment, a thallium doped sodium iodide
scintillator is used. It has a very good light yield in the whole relevant spectral region
(see fig. 3.6.
On the other hand, NaI(Tl) is fragile and hygroscopic, which makes insulation from
air necessary. Due to their regular structure, inorganic crystals have pronounced band
structure features. The scintillation process can thus be described using the band model
(see fig. 3.7).
The valence band contains electrons bound to individual molecules, while the conduc-
tion band is filled with electrons which are free within the material. When energy is
deposited in the crystal, electrons are lifted from the valence into the conduction band.
When the electrons fall back to the valence band, a photon with energy E1 is emitted.
Since this energy corresponds to the difference between valence and conduction band
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Figure 3.6.: Light yield of electrons and α-particles depending on their kinetic energy.

levels, the photon can be absorbed again. Thus, the material is opaque to the pho-
ton. To prevent this, activator atoms (here: thallium) are introduced into the crystal.
The activator atoms cause additional energy levels close to the conduction band to be
created. Electrons in the conduction band can now return to the valence band in two
steps. They first fall into the activator states, which causes a phonon, but no photon
to be created. In a second step they fall down from the activator states to the valence
band, which causes emission of a photon. The photon now has an energy E2 which is
too small to cause additional excitations. The material is thus transparent to the photon.

3.2. Momentum resolution

This experiment is basically a momentum spectroscope, which is sketched in figure 3.8.
Electrons are produced by the source S and pass through an opening of width ∆x1 into
the magnetic field. Here, they are deflected and then detected using the detector D. In
front of the detector, there is a cover with an opening of width ∆x2. Determine the
momentum resolution assuming that electrons enter the magnetic field parallel to the x
direction.
5;6800;1c
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Figure 3.7.: Scintillation process of an inorganic scintillator visualized using the band
model.

Figure 3.8.: Schematics of a momentum spectroscope.
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4. Execution

4.1. Momentum measurement in a magnetic field

0. Always modify slowly the current feeding the coils of the magnet to reduce the
probability to have residual magnetic field at zero current (BM = 0 at IM = 0).
The current must always be set to a value lower than 5A (IM < 5A).
In addition, check that the aperture between the two poles of the magnet is less
than 0.5 - 1 cm... Why?

1. Use the hall probe to measure the magnetic field between the pole pieces of the
electromagnet; the grid drawn on the surfaces serve as a reference. Check where
the magnetic field is homogeneous and how different currents affect the temporal
behavior of the field. To do this, perform 60 seconds long measurements for differ-
ent currents (sampling every 0.2 sec or whatever you find reasonable). Attention:
connect the hall probe to the USB port on the right.

2. Use the available supplies to construct a setup for the measurement of the mo-
mentum spectrum of 90Sr. Take care to choose a sensible and convenient position
for source and GM counter. Ask your supervisor to check the setup before
putting it into operation!

3. Measure the count rates in dependence of the magnetic field. Vary the field in
appropriate steps. The settings of the power supply might be too coarse to vary
the field as precisely as you would like. In this case, use the pole piece screw to
adjust the field. Always keep the Hall probe into the aperture between the poles,
in a fixed position OUTSIDE the electron path! If the value you get is slightly
different from the one in the center of the magnet, you have to rescale it: use the
field map measured in the point 1.

4. To estimate background levels, measure the count rate without a magnetic field.
Correct your measurement accordingly.

5. Save your data before leaving the lab using a readable file format.

Note: The available hall probe works in transversal mode. Its measurement range is
either 0 − 2mT or 0 − 2T. Depending on the chosen settings, it can measure constant
or time dependent fields. Software to extract measured data is available.
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4.2. Energy loss in matter

0. Do not change the supply voltage (500V). Turn on the HV of the PM after
having opened the program and turn it off before closing it.

1. When you collect the data, always check to have enough statistics. Tip: Save the
data in .TKA extension, which corresponds to an easy readable text file...

2. Measure the spectrum of 90Sr without any absorber. Adjust the amplification
factor such that the complete spectrum is recorded.

3. Measure the spectra of 22Na, 137Cs, 60Co and 152Eu. These should enable you to
do an energy-to-channel calibration.

4. Measure also the background... And use it properly!

5. Measure the spectra of the 90Sr with the aluminium absorbers of different thick-
nesses (at least 4 → 0mm not included!).

4.3. Multiple scattering

The setup consists of 3 (or 4) GM counters read out by an Arduino - RaspberryPi chain.
A sketch of the setup is shown in figure 3.3. Make the most out of the multiple GM
counters on the setup, by chosing appropriate angular steps.
Run the following command on the RaspberryPi in order to read the counts:

python counter number only . py

This will give you insights on the rate with which you can evaluate the acquisition time
for your measurement. When you are ready to start scanning the counts over the angle,
run the following command:

python Auto readout . py

Calibration

The GM counters have to be calibrated, since they do not return the same number
of counts when exposed at the same particle flux. The tutors will provide calibration
factors. The GM counters are already instelled their mounts. The radioactive source
is placed inside the collimator (aluminum piece), can slide inside the collimator, but
cannot pass through the openings.

Measurement of Multiple Scattering

1. By using a metal stick, push the radioactive source as far away as possible from
the opening that faces the GM counters. This is the source Position A.
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2. Measure the angular distribution of the electrons for the 90Sr source without and
with absorbers, choosing reasonable angular steps based on how you expect the
distribution is. At least you should use 4 different thicknesses of aluminum and
4 different materials with the same thickness (compare it to the aluminum if it is
not clear what is the size). Take care to choose sensible measurement times and
consider the measurement of the background.

Measurement of the beam profile

The intensity and the collimation of the electrons beam hitting the GM counters, depend
on the source positioning.

1. By using a metal stick, push the radioactive source as close as possible to the
opening that faces the GM counters. This is the source Position B.

2. Measure the angular distribution of the electrons (beam profile) without absorbers.
Choose reasonable angular steps based on how you expect the distribution is.

3. Restore the radioactive source back in Position A. Measure again the beam profile
without absorbers in order to assess the reproducibility of the measurement.

Deadtime measurement of the GM counter

There is a spare Geiger-Mueller counter available to use for this part of the experiment.
Therefore, please leave the GM counters attached to the apparatus within the aluminum
shielding.
In this part of the experiment you will use an oscilloscope (in this case the Picoscope)

to measure the analog signal output from the GM counter. From collecting these signals
over some time window, one can measure the time between the initial signal pulse to
the next pulse received. This is the deadtime, Td, the window of time in which the
gas detection volume needs to “reset” to be able to see a signal. This can be seen in
Fig. 4.1. This first signal after the initial deadtime is smaller than the primary peak
and subsequent signals recorded grow in amplitude. After some number of peaks, or
additional time, the signal peak returns to it’s original amplitude. The time in between
the initial peak and the signal returning to this amplitdue is called the recovery time,
Tr. You will measure the deadtime and recovery time of this GM counter.
To measure the deadtime, first confirm that the Picoscope is connected properly. To do

this, first make sure that the USB cable is connected between the PC and the Picoscope.
Next, connect the BNC connector of the probe into Output A. Then, connect the hook
end of the probe lead to the leg of resistor R4 that is nearest the capacitor C2, as shown
in Fig. 4.2. Also connect the ground lead of the probe to the GM voltage supply ground
pin, also shwown in Fig. 4.2.
Next, confirm that the GM counter is connected to be powered by the Raspberry Pi

or the Arduino. The 3.3 V pin of the GM counter needs to connect to the 3.3 V pin of
the microcontroller. The ground pin should be connected to the microcontroller ground
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Figure 4.1.: An example Stever diagram showing the deadtime, Td, and the recovery
time, Tr of a sample detector.

pin. The GM counter pin locations are shown in Fig. 4.2. If you are unsure about the
connections, confirm with the tutor prior to performing the experiment.
The settings listed in Table 4.1 should be used. The Persistance mode settings will be

used later, you need not apply those at this point. We place them here for completeness
and reference for later.

Table 4.1.: Settings associated with MightyOhm signal display using the PicoScope soft-
ware. Some settings are only applied in Persistence Mode.

Settings Values
Input range ±2 V
Collection time 50 µs/div
Offset -1.8 V
Resolution 16 bits

Trigger
Trigger Mode Repeat
Trigger Simple
Edge Select Rising Edge
Threshold ≈ −600 mV
Pre-Trigger ≈ 5%

Persistence Mode only
Mode Digital Color
Saturation ≈ 65%
Decayed Intensity ≈ 15%

In the Appendix, there is a more in-depth discussion of the various settings for the
Picoscope. If anything regarding the Picoscope software settings is unfamiliar or you are
unsure about, check there first. To measure the output signal using the Picoscope, first
confirm that you can read the output and get a single peak using the “Scope mode” of
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Figure 4.2.: Setup for the GM counter. The hook tip of the PicoScope probe is con-
nected to the leg of the resistor R4 which faces to the capacitor C2 (green
circle). The ground lead attached to the probe is connected to the ground
of the voltage supply (crocodile clips on the right). Ground (black wire)
and voltage (3.3V, red wire) are connected to the board (top). Warning:
High voltage is now present across the GM tube.

the Picoscope. As a check, collect several events using comic ray muons as the source.
The data collected by the Picoscope in this mode should appear similar to that in Fig.
4.3.
To find the deadtime, place the counter inside the aluminum volume such that the

GM counter is within the acceptance region of the Sr-90 source. From here use the
Persistance mode of the Picoscope software. The output in Persistance mode will show
a color gradient based on the signal multiplicity (red=most common and blue=least
common). This can be seen in Fig. 4.4. It can be helpful to suppress some of the
gradient using the Phosphor option as shown in Fig. 4.5. As you can see, the gradient
scale is suppressed, mostly leaving the signals that you are interested in allowing for
easier determination of the deadtime and recovery time.
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Figure 4.3.: A single GM counter pulse collected by the Picoscope.

Figure 4.4.: The Persistance mode allows for generating the Stever diagram. In this
mode a color gradient is present that corresponds to how freqent a signal is
measured. Red shows most the common and blue the least.
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Figure 4.5.: In Persistance mode, using the Phosphor options it is possible to reduce
the amount of signals that are not interesting allowing for a more accurate
determination of the deadtime and recovery times.
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5. Analysis

❼ Present the measured magnetic field properties appropriately and discuss them.
Is the magnetic field sufficiently homogeneous or do you need to use an effective
average? Where does the magnetic field become inhomogeneous?

❼ Plot the momentum and energy spectra. Transform the spectrum into a Kurie
diagram, with and without Fermi correction. Use it to determine the maximal
energy of the spectrum and estimate the uncertainty of Emax. What effect does
the Fermi correction have?

❼ Perform an energy-to-channel calibration for the scintillator.

❼ Plot the measured energy spectra. Present all spectra with aluminum absorbers
in the same diagram. Do the same for the spectra with absorbers of the same
strength. Once again, create Kurie diagrams and determine Emax and its uncer-
tainty.

The aluminum shielding has a nominal area mass density of X = 147 mg

cm2 . The scintillator crystal

is covered by an aluminum-oxide reflector with density ρ = 3.94g/cm3. The reflector is meant

to prevent scintillation photons from leaving the scintillation volume, thus increasing the light

yield. It has a nominal thickness of 1.6mm and an area mass density of 88 mg

cm2 . The reflector

and aluminum shielding must be considered in the analysis of your data.

– Compare your results to theory.

– Are the nominal specifications correct?

– Discuss your results.

❼ Mutliple Scattering Measurement: For each used absorbers, plot the rate measured
by each GM counter versus your reference angle (position of the flag on the pro-
tractor). Are these angular distributions compatible with a gaussian distribution
gaus(A, µ, σ)? If yes, you have to normalize the rates of different counters: for the
absorber ab:

1. collect the fit parameters µab
GM1, µ

ab
GM2, µ

ab
GM3, µ

ab
GM4;

2. for each counter GMi rescale the point
(refAngle, rate) → (refAngle -µab

GMi , rate);

3. plot all the rescaled points related to the absorber ab in the same diagram;

4. fit these points with a gaussian distribution and collect the fit parameters
Aab

all, µ
ab
all, σ

ab
all;
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5. repeat steps 1-4 for all the used absorbers.

Consider the fit parameters obtained without absorbers (Air) and with the 4 thick-
nesses of aluminum.

1. Plot σab
all versus thickness;

2. Plot Aab
all versus thickness;

Describe quantitatively the results.

❼ Deadtime and Recovery time Measurement:

1. From the Stever diagram, determine the deadtime and the recovery time of
the GM counter.

2. Do your results make sense? Support with reasoning.

3. Is there are range for the rate for where the meausrement of a radioactive
source is severely limited by the deadtime of this detector and one should use
another detector. Why or why not?

❼ Source Profile Measurement: you have measured and fitted the angular distri-
butions for two different source positions (Position A and Position B). Plot both
angular distributions in the same diagram. What are the differences in the angular
distributions and the beam rates between these positions? How can you explain
them?

❼ Compare the two angular distributions you have measured for the source in Posi-
tion A and fit them with a gaussian distribution. How much do the fit parameters
differ each other? Is the difference caused by a statistical and/or systematic error?

❼ You have measured the maximal energy and momentum of charged particles. Cal-
culate the particle mass! Discuss uncertainties. Can this result be used to identify
the particles?

❼ Briefly discuss how these measurement methods are used in modern detectors.
What does this tell us about a ”good” detector?

❼ To what class does the transition from 90Y to 90Sr belong?

Many of the results from this experiment will have limited precision (e.g. the mass
measurement). Your analysis should focus on correct handling of uncertainties. It
should reflect your understanding of principles and methods. Many plots can be put
into the same figure. Important results should be given in the text or in tables.
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Appendices
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A. Useful plots

A.1. Sources

The gamma emitters 22Na, 137Cs, 137Co and 152Eu are used for energy calibration. The
used β-source is 90Sr with activity of 1 MBq. The decay scheme is shown in fig. A.1.

Figure A.1.: Decay scheme of 90Sr.
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A.2. Fermi integral

Figure A.2.: Logarithmic view of β−decay spectra at different nuclear charges.
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B. Charged particles in magnetic fields: equation of motion

In this appendix, we want to go though the computation of the equation of motion of a
particle inside a constant magnetic field (Fig. 2.3).

Without loss of generality, we choose our coordinate system such that

v⃗ =





v0
0
0



 , B⃗ =





0
0
B



 (B.1)

which gives us the equation of motion

m ⃗̈x = q v⃗ × B⃗ (B.2)

with the initial conditions

x(0) = 0, y(0) = 0, ẋ(0) = v0, ẏ(0) = 0 (B.3)

where t = 0 is the time at which the electron enters the magnetic field. We suppress
explicit time dependencies and write the separate components:

ẍ =
q

m
Bẏ (B.4)

ÿ = − q

m
Bẋ (B.5)

This is a system of coupled differential equations. Performing time integration yields

ẋ =
q

m
By + C1 (B.6)

ẏ = − q

m
Bx+ C2 (B.7)

where the integration constants C1 = v0 and C2 = 0 are determined from the initial
conditions ẋ(0) = v0, y(0) = 0 and ẏ(0) = 0, x(0) = 0. By putting eq. B.7 into B.4,
the differential equations are de-coupled:

ẍ = −(
q

m
B)2x (B.8)

Equation B.8 describes a harmonic oscillation and is solved by
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x(t) = A1 coswt+ A2 sinwt, w =
q

m
B (B.9)

Using the initial condition x(0) = 0, we get A1 = 0. Also, we deduce ẋ(0) = v0 ⇒ A2 =
v0
w

and arrive at

x(t) =
v0
w

sinwt (B.10)

We put B.10 into B.7 and get

ẏ = −v0 sinwt (B.11)

integrating one more time yields

y(t) =
v0
w

coswt+ C3 (B.12)

Where we have determined C3 = −v0
w

from y(0) = 0.

y(t) =
v0
w
(1− coswt) (B.13)

The final solution is then

r⃗ =





x(t)
y(t)
z(t)



 =





v0
w
sinwt

v0
w
(1− coswt)

0



 (B.14)

As we expected, this equation of motion describes a circular path. This is due to the
Lorentz force, which acts as a centripetal force.

37



C. Using the Picoscope

C.1. Introduction of the PicoScope

[LE,RO]Introduction

C.1.1. Setup of the PicoScope

Hardware

Usually, the PicoScope oscilloscope can be used in the experiments without major
changes to the existing experimental setup.
The power supply of the PicoScope oscilloscope is plugged in and the oscilloscope is
connected to a PC via an USB cable. Four independent channels can be connected via
the BNC connectors on the front. For instance, probes which are delivered with the
PicoScope can simply be connected to such an input.
The used PicoScope model also features an output channel which can be adjusted with
the software such that it outputs the defined function.
The described input and output connections are displayed in Figure C.1.

Software

On the homepage of pico Technology, the software PicoScope can be obtained which
has to be installed to access and control the PicoScope oscilloscope. After starting the
software, the PicoScope oscilloscope should connect automatically.
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C.1.2. Using the software

The basics for operating the PicoScope software are explained in this section. Also some
advanced features will be described as they proved useful in the actual experiments of
the lab course.

General remarks

Depending on the context, it can be advantageous to save certain settings of the Pico-
Scope in order to load them at a later time. This can be achieved at File → Start-up
Settings → Save Settings As... and a setting file is accessed by either opening it in
the Windows Explorer (if automatically associated with the PicoScope software) or use
File → Open. In the menu Start-up Settings it is also possible to set default settings
which are always loaded when starting the software or set the option to restore the set-
tings of the last PicoScope session. The latter option is especially useful if one wants to
continue with some work in the software after it was closed. Therefore, it is advised to
activate this option as default settings if no user default settings are set.

Scope Mode and Persistence Mode

Two different view modes are used in the lab course. The Scope Mode shows the sig-
nal captured during the Collection Time once. The Persistence Mode overlays multiple
recorded signals and fades out the signals with time. This behaviour can be associated
with the afterglow of signals on an analog oscilloscope.
Both modes share many settings regarding the display of the signal (e.g. Input Range
and Offset) which are explained in Section C.1.2. However, the Persistence Mode fea-
tures additional settings to modify the afterglow effect. Most important are the Mode
setting (cf. Fig. C.2) where Digital Color uses different colors to indicate how often a
certain signal value occurs at a given time and Analog Intensity draws recent signals with
full intensity while signals get paler with time. The options Decay Time, Saturation and
Decayed Intensity define the time how long a signal takes to fade out, the intensity with
which a new signal is drawn and the intensity at which signals remain after the decay
time elapsed, respectively.
A special characteristic of the Scope Mode is the possibility to save waveforms not only
as an image but also the data points in a csv or txt file. This is emphasized in Sec-
tion C.1.2 and not possible in the Persistence Mode. It is also possible to view some
previously captured signals which are stored in the buffer. Another view mode is the
Spectrum Mode which uses a fast Fourier Transformation to display a spectrum view.
As this mode is not used in the lab course currently, this feature is not covered here in
further detail but information can be found in the PicoScope user’s guide. Both view
modes are shown in Figure C.2.
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Changing the display of the input signal

The different options to modify the display of the signal are explained using Figure C.3.
The green boxes show the options which apply to all channels.

(1) The Collection Time determines how long a capture of a signal lasts. Usually, the
time is stated per division . The total time is derived by using a factor 10 for the
number of divisions.

(2) The Number of Samples does only need attention in some cases. The number
stated is an approximate value. In the menu Views → View Properties, the actual
number of samples as well as the sampling interval can be seen. For many purposes
the default set value of Number of Samples is sufficient but for short-lived peaks
and large Collection Times the sample interval should be considered eventually.

(3) The Hardware Resolution can take values from 8 to 16 bits and determines the
quality of the digitized signal. Note that 15 bits and 16 bits resolution are only
possible if two and one channel, respectively, are used. Using the option Auto
resolution is usually sufficient.

(4) The zoom functions can be used to enlarge a region of the scope and investigate
the waveform closer without changing the Input Range or Collection Time.

The following options can be adjusted for each channel individually.

(5) The Input Range option determines the minimal and maximal input value for the
channel. A channel can also be turned off. If the recorded signal is larger than the
Input Range, a warning (Channel overrange) is displayed in the upper left corner
and the input range should be increased.

(6) The Coupling can be set to AC or DC. In the AC mode, frequencies ≲ 1 Hz
are filtered out. Therefore, DC offsets are not visible, allowing for more precise
signal measurements but relative voltages with respect to the ground cannot be
measured. In the DC mode, the signal is measured with respect to the ground.

(7) An Analog Offset can be applied to the input before digitization. This is useful
cases where the maximum amplitude is known, e.g. if pulses with height 10 V are
expected, the Input Range of ±10 V does not have to be used but ±5 V with an
Analog Offset of −5 V.

(8) The Axis Scaling options can be used to manipulate the display of the signal. In
contrast to the Analog Offset, these options apply to the axis not the signal.

Trigger

A plethora of triggers is available which are especially useful for finding rare and short-
lived signals. The options are explained with Figure C.4. All options regarding trigger
are set in the menu bar at the bottom of the software.

(1) Different Trigger Modes are available determining what signals are displayed. The
most important are

– None: No trigger is used.
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– Auto: Displays a triggered waveform but if no present the input signal is
displayed regardless of the trigger.

– Repeat : Displays only triggered waveforms.

(2) Advanced Triggers can be used but usually the Simple Edge trigger is sufficient
which fires when the signal passes through a certain threshold. The other triggers
have additional features, e.g. allowed voltage windows for the signal. The options
(3)-(5) can also be adjusted in this context menu.

(3) Usually, the Trigger Channel is the same as the displayed signal. If multiple inputs
are displayed, one channel has to be chosen which triggers for all inputs. It is also
possible to trigger on an external channel.

(4) The Edge Select option allows to trigger on either falling or rising edges.
(5) The Threshold can be typed in at the menu bar, in the Advanced Triggers menu

or by dragging the marker (yellow square in the scope) at the desired position.
(6) The Pre-trigger determines how much of the signal is captured and displayed before

the trigger fires. It can also be adjusted by dragging the marker in the scope.
(7) The Trigger-delay has to be enabled by clicking on the respective item in the menu

bar and determines how much time has to elapse before the trigger can fire again.

For most purposes, the Simple Edge trigger with a sufficient Threshold and Pre-trigger
and correct Edge Select is sufficient.

Saving waveforms

The PicoScope software features the saving of captured waveforms either as an image
or a csv/txt file if the Scope Mode is used. The latter file types store single data points
and are useful to analyze the waveforms with another software.
Saving a waveform can be accessed via File → Save or Save As. The appearing window
allows to select a file location and filename for the file. Different file formats such as
files readable by the PicoScope software (e.g. pssettings and psdata), text files (e.g. txt
and csv) and images (e.g. png and jpg) can be chosen. The options in the window allow
to save only the currently displayed waveform, all waveforms in the buffer or a subset
of the buffered waveforms. If not using a PicoScope file type, a separate folder will be
created if multiple waveforms are saved.

The PicoScope also allows to save the waveform automatically every time the trigger
fires. For saving waveforms when the trigger fires, an alarm has to be set up in the menu
Tools → Alarms. In the Alarms dialog window, the event has to be set to Capture and
the first item (usually it has the name Beep) of the list has to be selected and edited.
The action is changed to Save Current Buffer and a directory in which the files are
saved has to be chosen. It is important to set the file type explicit to a csv-file if one
wants access the data points and not only obtain an image of the waveform. The stated
filename will be used for all files and numbered serially. E.g. the filename is set to be
waveform. Then the first file is waveform.csv, the second is waveform (2).csv, the third
is waveform (3).csv etc. The set up of the alarm is finalized by closing all dialogs with
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the Save (German: Speichern) or OK button. When starting the capturing of signals in
the PicoScope software (green triangle in lower left corner), every time the trigger fires,
the currently displayed waveform is stored as csv-file. To turn off the saving of pulses,
it is easiest to stop the signal capture (red square in the lower left corner) and turn of
the alarm in the alarm dialog window. The whole process is described in Figure C.5.

Measurements

The PicoScope allows to infer several values of the captured signals. These measurements
can be used to count falling or rising edges which is useful in many experiments of the
lab course whenever peaks are counted. Therefore, this introduction focuses on this
measurement but counting peaks is not the only measurement featured by the PicoScope
software.
A measurement is set up (c.f. Fig. C.6) viaMeasurements → Add Measurement (1a) or by
clicking on the + on the lower menu bar (1b). In the appearing context window, multiple
settings have to be set. The input channel is assigned (2). Multiple measurements of
different quantities for different channels are possible. The type of measurements is
defined (3) which is Falling Edge Count or Rising Edge Count if the number of peaks
is supposed to be measured. It is possible to use the whole trace for a measurement or
only a latter defined interval ∆t (4). The measurement options allow either a threshold
to be defined or an automatic threshold to be used (5). The hysteresis can be leaved
unchanged. This parameter is linked to a mechanism that prevents wrongly counts due
to fluctuations of the signal near the threshold. More information on that are provided
in the PicoScope user’s manual. If the options to use the whole trace and an automatic
threshold, the measurement is ready to start. Otherwise, the rulers on the horizontal and
vertical axis have to be adjusted to determine the measurement range and the threshold,
respectively (c.f. Fig. C.7). The values can either by typed in the ruler legend or defined
by dragging the rulers to the desired position. The measurement is found at the bottom
with multiple values shown.

❼ The used Channel and Measurement mode are shown.
❼ The Value refers to the counted edges in the currently displayed waveform.
❼ The values Min and Max show the minimum and maximum counted edges, re-
spectively, in a waveform.

❼ The Average is defined by the arithmetic average of the counts in the waveforms.
❼ The standard deviation σ is defined by σ2 = 1

N−1

∑N
i=1 (yi − ȳ)2 where N is the

number of captured samples, yi the number of edges in the i-th sample and ȳ the
mean of counted edges over all samples.

❼ The Capture Count determines how many captured samples are considered. More
samples result in better statistics but need more time to be collected. In case
the number of captured samples exceeds the Capture Count, every new samples
replaces the oldest considered sample. Consequently, the other values such as Min
and Max only refer to the currently considered samples and not to all samples ever
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captured. The Capture Count can be changed at Tools → Preferences → General
→ Measurement Statistics.

❼ The Span shows if a ruler-defined ∆t is used or the whole trace.

In Section ?? a description is provided on how to access the measured values automati-
cally.
Note that a measurement can fail which is displayed by - - in the overview of the mea-
surement results. This problem can usually be solved by either decreasing the Collection
Time or by reducing the Number of Samples. Which solution is better depends on the
context of the measurement but if using the latter solution one should check that the
sampling interval is still large enough to capture the signals.
Note: When using large Collection Times (≥ 100 ms/div), the PicoScope has to be
hindered to go into the Slow Sampling Mode otherwise wrong measurement results are
obtained. This is achieved at Tools → Preferences → Sampling → Slow Sampling Tran-
sition. Here, a Collection Time larger than the one used in the measurement has to be
chosen.

Math Channel

The PicoScope software features Math Channels which allow to manipulate one or mul-
tiple inputs with mathematical expressions. The output is displayed as an additional
waveform in the scope and can also be used as an input channel for measurements.
Math Channels are accessed via Tools → Math Channels. The featured built-in opera-
tions are inverting the signal, adding, subtracting, multiplying and dividing two signals.
It is also possible to define functions by clicking on Create in the Math Channel menu
and entering the desired expression.
An application of Math Channels is the implementation of a coincidence counter. Two
input channels which are assumed to be 0 V by default, i.e. in the digital LOW state,
and have a non-zero voltage if they are in the digital HIGH state are multiplied. Only
if both channel are in the digital HIGH state, the function has a non-zero output which
is an implemented logical OR gate. In order to count the number of coinciding events,
a measurement counting the rising or falling edges of the function can be used.
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Figure C.1.: An overview over the inputs and outputs of a four channel PicoScope.
Source.
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Figure C.2.: Displaying the signal in the Scope Mode (top) and Persistence Mode (bot-
tom). The blue arrows indicate where the view modes can be accessed. The
orange arrow shows the menu for the buffered waveforms and the green ar-
row marks the options for the Persistence Mode. A trigger has been in both
view modes.
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Figure C.3.: Options to modify the display of signals. THe Scope Mode is used. Further
information can be found in the text.

Figure C.4.: Trigger menu (green) at the bottom of the PicoScope menu. The context
menu of the Advanced Triggers (blue) is shown. Further information can
be found in the text.
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Figure C.5.: Saving pulses on trigger. In the Alarm dialog window (1), Capture has to
selected as event by checking the tick box (2). A new dialog window is
opened (lower image) by editing the item in the list (3). The action is set
to Save Current Buffer (4) and the directory, filename and file type are
specified (5, 6) in the next dialog window. The file type should be set to
csv if the data is analysed with another software afterwards. At last, all
windows are closed (blue boxes).
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Figure C.6.: The measurement window (green frame) is opened via the menus indicated
by the blue arrows. Further information can be found in the text.
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Figure C.7.: Finalizing the measurement by adjusting the ruler (green arrows) or using
the ruler legend (blue arrow). The measurement results are displayed at
the bottom (orange arrow). Further information can be found in the text.

49


	Introduction
	Theory
	-decays
	The -spectrum
	Fermi correction
	Allowed and prohibited transitions
	Kurie diagram

	Bending charged particles in magnetic fields
	Particle's momentum measurement in CMS and tracking detectors

	Energy loss of electrons in matter
	Ionization
	Bremsstrahlung

	Multiple scattering

	Experimental setup
	Detection devices for nuclear radiation
	Geiger-Müller counter
	Scintillators

	Momentum resolution

	Execution
	Momentum measurement in a magnetic field
	Energy loss in matter
	Multiple scattering

	Analysis
	Appendices
	Useful plots
	Sources
	Fermi integral

	Charged particles in magnetic fields: equation of motion
	Using the Picoscope
	Introduction of the PicoScope
	Setup of the PicoScope
	Using the software



